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There are three categories of T3 Professional Development, each with a unique set of learning objectives.
This workshop is focused on technology integration, and its objectives are as follows:

Technology Integration
Emphasis on learning to use TI technology, with broad “how-to” coverage highlighting a 
wide range of features
Subject/content-focused training on appropriate usage of TI technology in the classroom

I am comfortable with essential technology skills for exploring math and science content.
I can design opportunities for students to use technology as a tool to deepen their 
understanding of mathematics and science.
I can locate and download TI activities that align to my standards.
I can describe the role technology should play in the successful implementation of my 
standards, and I can implement a vision of a classroom where students routinely use 
technology to engage in the practice and content standards.

Workshops focused on instructional practices and content knowledge have the following objectives:

Instructional Practices
Emphasis on classroom practices with technology as a tool to enhance student learning
Models CCSS, TEKS, and STEM tasks using in-depth discussions, reflective practices, and 
essential technology skills

I can demonstrate the importance of teacher actions for students’ engagement in the 
Practices, and I can take actions that will enable students to become mathematical 
and scientific practitioners.
I can describe the role that technology should play in the successful implementation 
of my standards, and I can implement a vision of a classroom where students 
routinely use technology to engage in practice and content standards.
I can design tasks for students to employ the Practices, using technology as a tool to 
deepen their understanding of mathematics and science.
I can ask questions designed to make student thinking visible – to push them to think 
about connections, make comparisons, or probe their understanding. 

Content Knowledge
Emphasis on content with technology as support
Addresses critical, tough-to-teach topics and new content standards for CCSS or TEKS

I have a deeper understanding of the mathematics and science in my content area, 
and I am aware of the shifts in content that affect what I teach.
I can design opportunities for students to use technology as a tool to deepen their 
understanding of mathematics and science.
I can locate and download TI activities that align to my standards.
I can describe the role technology should play in the successful implementation of my 
standards, and I can implement a vision of a classroom where students routinely use 
technology to engage in the practice and content standards.
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I can…

Enter data into the built-in Lists & Spreadsheet application. 

Add a page to an existing document.

Set up a plot in the built-in Data & Statistics application. 

Plot a function.

Use a moveable line to approximate a pattern.

Locate a TI-Nspire™ activity on education.ti.com.

Download and open a TI-Nspire™ document. 

Send a TI-Nspire™ document from a computer to a handheld. 

Collect data using Events with Entry Mode in the built-in Vernier DataQuest™ application. 

Recognize functional patterns in data.

Use the Documents Workspace in the TI-Nspire™ CX Navigator™ Teacher Software.

Recognize the application of different question types.
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Activity Overview
This activity describes how to enter data into a Lists & Spreadsheet application and then generate a 
graph of the data using Quick Graph. Additionally, data are graphed on a separate page using the Data & 
Statistics application.

Part One – Preparing the Document

Step 1:

Press c. Select New Document to open a new document.

Step 2:

Select Add Lists & Spreadsheet. 

Note:   To add a Lists & Spreadsheet page to an existing document, press / ~ and select
Add Lists & Spreadsheet. Alternatively, press c and select using the Touchpad.

Part Two – Entering and Graphing One-Variable Data

Step 3:

In column A, press £ on the Touchpad to move to the cell at the 

top of column A.

Step 4:

Type the list name height next to the letter A. Press ·. 

Step 5:

Press on the Touchpad and move down to cell A1. Enter the 
following 15 values for height. Pressing · or will move the 

cursor to the next cell in the column.  
{55, 50, 58, 47, 68, 52, 50, 55, 50, 58, 58, 62, 66, 58, 61}
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Step 6:

To graph the data, move the cursor to one of the data cells in 
column A. Select Menu > Data > Quick Graph. 

Note:    The screen will automatically split vertically—the Lists & 
Spreadsheet application remains in the left work area 
while a Data & Statistics application is inserted in the 
right work area. A dot plot appears.

Step 7:
To change the graph to a box plot of the data, select Menu >
Plot Type > Box Plot. 

Using the Touchpad, move the cursor over the box plot to view 
values for the minimum, first quartile, median, third quartile, and 
maximum.

Step 8:
To change the graph to a histogram of the data, select Menu >
Plot Type > Histogram.

Part Three – Entering Two-Variable Data

Step 9:

Insert another Lists & Spreadsheet page by pressing / ~

and choosing Add Lists & Spreadsheet. Alternatively, you may 
press c and select using the Touchpad.
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Step 10:

In column A, move up to the top of the column. Type the list name 
height. Press ·. The list will automatically populate using the 

height data from page 1.1.

Note: Alternatively, move to the top of the column, press h, 

select Link To:, and select the list height.

Step 11:

In column B, move up to the top of the column. Enter the list 
name armspan. Press ·.

Step 12:

Press on the Touchpad and move down to cell B1.

Enter the following values for armspan.

{53, 50, 56, 45, 67, 53, 49, 53, 51, 58, 59, 61, 64, 55, 61}

Part Four – Graphing a Scatter Plot Using Quick Graph

Step 13:

To make a scatter plot of (height, armspan), select both lists.

Place the cursor in a cell in the height column. Press £ to move 

to the top of the list until the entire list is highlighted.

Press and hold g, and press ¢ to move to the right and 
highlight both lists. Release the g key. 

Step 14:

Select Menu > Data > Quick Graph. 

The screen will automatically split vertically—the Lists & 
Spreadsheet application remains in the left work area while a 
Data & Statistics application is inserted in the right work area. 
A scatter plot appears. 

Note:  The dark rectangle around the Data & Statistics application work area indicates that 
the application is active. To move from one work area to another, press / e
or use the Touchpad to move to the desired application, and press x to select it.
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Part Five – Graphing Data on a Separate Data & Statistics Page
  
Step 15:

Press / ~, and insert a Data & Statistics page.

Step 16:

Press e, and select height for the independent variable.

Alternatively, click on the “Click to add variable” message in the lower 
part of the screen, and select height. 

Step 17:

Press e, and select armspan for the dependent variable. 

Alternatively, click on the “Click to add variable” message on the left 
side of the screen, and select armspan. 

Part Six – Add a Movable Line and Adjust to Fit the Data

Step 18:

Select Menu > Analyze > Add Movable Line.

Step 19:

To translate the line, move the cursor to the line near the middle
of the screen. When the translation symbol (ö) appears, press 
/ x to grab the line. Use the Touchpad to translate the line. 
When finished, release the line by pressing x or d. 

Step 20:

To rotate the line, move the cursor to the line near the edge of 
the screen. When the rotation symbol (é) appears, press /
x to grab the line. Use the Touchpad to rotate the line. When 
finished, release the line by pressing x or d.
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Open the TI-Nspire document Will_It_Float_or_Sink.tns.
Why do some things float and others sink? Have you ever wondered 
why ice floats in water? Have you wondered why a rock sinks in 
water, while polystyrene foam floats? What physical properties make 
some objects float and others sink? In this activity, you’ll use a 
simulation to explore these questions.

Density is a physical property that indicates whether an object will sink or float. Density is the ratio of an 
object’s mass to its density.

The units for density in this simulation are grams per milliliter, or g/mL. When an object floats on water, 
then the density of that object is less than that of water. 

The same idea applies with liquids. If you were to combine oil and water, eventually the layer of oil would 
collect above the layer of water. This is because oil is less dense than water.

The simulation contains a virtual density column. Four beakers with different liquids (called solutions) of 
different densities are shown. Your task is to calculate the density of each of the four solutions. Then, 
based on the results, predict the order in which the layers will settle. Finally, you will predict where a solid 
object will float when dropped into the column.

Move to pages 1.2 – 1.3.
1. Move the cursor over a beaker, and you will see the mass and 

volume measures for a solution. Record this data in the table on
the next page. 
a. IMPORTANT: If you select the beaker, the liquid will be 

“poured” into the cylinder, forcing you to reset.
b. WARNING: When you press the Reset button , the values 

for mass and volume change to new values.
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Container 1 Container 2 Container 3 Container 4

Mass: _____________

Volume: ___________

Mass: _____________

Volume: ___________

Mass: _____________

Volume: ___________

Mass: _____________

Volume: ___________

2. Use the Calculator page 1.3 or the Scratchpad to calculate the density of each solution.

Q1. What is the formula for calculating density? _______________________________

Container 1 Container 2 Container 3 Container 4

Density: __________ Density: __________ Density: __________ Density: __________

3. Once you have calculated the densities, return to page 1.2 and click on the solution containers in the 
order in which they will settle in a graduated cylinder.

If you select an incorrect order, you will “win a Goat”. Reset the page and try again.

4. Hover the cursor over the solid ball to reveal the mass and volume.

Mass: _______________________  Volume: _______________________

5. Use the calculator page 1.3 to calculate the density of the solid ball.

Density of Solid Ball: _______________________

6. Use the arrows beside “Predict Level” to move the red arrow next to the graduated cylinder to show 
where you predict the ball will float in the column.

7. Select the play button to watch the ball fall through the density column. If you correctly predicted 
the location of the ball, you will receive a “Gold Star”. If you did not predict the correct location of the 
ball, you will “win a Goat”. Press the Reset button and try again until you receive the Gold Star.
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Move to pages 2.1 – 2.5. Answer questions 2 – 6 below and/or on your handheld. 

Q2. When poured into the graduated cylinder, the densest liquid will _________.
A. float on top
B. be the middle layer

C. be the bottom layer
D. mix together

Q3. As the solid becomes denser, it is most likely to ___________.
A. sink
B. float

C. rise to the top
D. hang in the middle

Q4. Density is __________.
A. how heavy an object is
B. the size of an object

C. volume divided by mass
D. how closely packed the matter is

Q5. The density of glycerin is 1.26 g/mL. If the mass of glycerin doubles, increasing from 125 g to 
250 g, the volume __________.
A. doubles
B. decreases by one-half

C. is unchanged
D. decreases by one-fourth

Q6. The density of glycerin is 1.26 g/mL. If the mass of glycerin doubles, increasing from 125 g to 
250 g, the density __________.
A. doubles
B. decreases by one-half

C. is unchanged
D. decreases by one-fourth
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Science Objectives
Students will calculate the density in g/mL given the mass of a 
liquid and its volume. 

Students will sort layers of liquids of different densities. 

Students will predict where a solid object of a given density will 
float in a density column. 

Vocabulary
density
float
liquid
mass
sink
solid
volume

About the Lesson
While students may associate flotation with a solid and a liquid 
(for example, ice floating on water), this lesson allows students to 
visually see the relationship between density of liquid solutions 
and the relative position of an object in the solutions based on its 
density.
As a result, students will:

Understand how solutions will separate based on their 
densities.

Predict where a solid object will float within the given 
solutions based on its given mass and volume. 

Using TI-Nspire™ Navigator™
Send out the Will_It_Float_or_Sink.tns file.
Monitor student progress using Class Capture. 
Use Live Presenter to spotlight student answers.

Activity Materials

Compatible TI Technologies:  TI-Nspire™ CX Handhelds, 

TI-Nspire™ Apps for iPad®, TI-Nspire™ Software

Tech Tips:
This activity includes class
captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld.
Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 
Access free tutorials at 
http://education.ti.com/
calculators/pd/US/Online-
Learning/Tutorials

Lesson Materials:
Student Activity

Will_It_Float_or_Sink_ 
Student.doc
Will_It_Float_or_Sink_ 
Student.pdf

TI-Nspire document
Will_It_Float_or_Sink.tns
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Discussion Points and Possible Answers

Have students read the background information on the student activity sheet. Review the concept of 
density with students. 

While students may normally associate flotation with a solid object floating in a liquid (e.g., ice floating in 
water), “flotation” also occurs with liquids. 

Move to pages 1.2 – 1.3.
1. Students should move the cursor above each beaker to see the

mass and volume data. As the cursor hovers over each beaker, 
students should record the data in the table below. 
a. IMPORTANT: If students select a beaker, the liquid will be 

“poured” into the cylinder and they will have to reset the page 
to remove the liquid from the cylinder using . This also 
resets the data for all the liquids.

b. Reinforce that when reset is pressed, the masses and volumes of ALL the liquids in the beakers 
change. They have to start over again.

Sample Data:
Container 1 Container 2 Container 3 Container 4

Mass: ___45.23 g____

Volume: ___30 mL___

Mass: ___25.28 g___

Volume: __20. 5 mL__

Mass: ____85.12 g___

Volume: __25 mL___

Mass: ___62.15 g____

Volume: __35.5 mL___

2. Students should use the calculator page 1.3 or the Scratchpad to calculate the density of each 
solution.

Guide students to use dimensional analysis if they cannot remember the formula for density. The 
units of g/mL are units of mass divided by volume.
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Q1. What is the formula for calculating density? _______________________________

Answer: massdensity
volume

Tech Tip: Students can press » to use Scratchpad instead of 

moving between pages 1.2 and 1.3 to perform calculations.

iPad Tip: Use page 1.3 to do calculation. The iPad does not have 

Scratchpad.

Sample Answers:

Container 1 Container 2 Container 3 Container 4

Density: __1.51 g/mL_ Density: __1.23 g/mL_ Density: __3.40 g/mL_ Density: __1.75 g/mL_ 

3. Once they have calculated all the densities, they should arrange them in order from greatest to least. 
Next the student should go back to page 1.2 and click on the solutions in the order they would be 
poured into the graduated cylinder—most dense first and least dense last.

If the student is not successful, he/she will “win a Goat” and have to reset the page to start over.

4. The student will then hover over the solid ball to reveal the mass and volume.

Sample Data:

Mass: ________18.11 g__________  Volume: ________5.00 mL_______________

5. Students can then return to page 1.3 or use Scratchpad to calculate the solid ball’s density.

Sample Calculation:

Density of Solid Ball: ______3.63 g/mL_______

6. Students then predict on page 1.2 where the solid will settle in the column. Be sure students 
understand which buttons are “predict” and which are “reset/play.”
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7. Students select the play button to test their predictions. If the prediction is incorrect, the student 
will have to reset the simulation and try again until they get a Gold Star.

Teacher Tip: If students have to reset because they incorrectly predicted 
where the ball will fall, they will start over again with new liquids.  

TI-Nspire Navigator Opportunities
Use Class Capture to monitor for “Goats” and “Gold Stars” as students progress through the simulation. 

Move to pages 2.1 – 2.5.
Have students answer questions 2 – 6 on the handheld, the activity sheet, or both.

Q2. When poured into a graduated cylinder, the densest liquid will ________.

Answer: C. be the bottom layer

Q3. As the solid becomes denser, it is more likely to ________.

Answer: A. sink

Q4. Density is _____________.

Answer: D. how closely packed the matter is

Q5. The density of glycerin is 1.26 g/mL. If the mass of glycerin doubles, increasing from 125 g to 
250 g, the volume of the glycerin ________.

Answer: A. doubles

Q6. The density of glycerin is 1.26 g/mL. If the mass of glycerin doubles, increasing from 125 g to 
250 g, the density of the glycerin ________.

Answer: C. is unchanged
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TI-Nspire Navigator Opportunities 
TI-Nspire Navigator can be used to make class captures to follow student progress. A visual check can 
be made to see which students are successful and which are struggling.

Wrap Up
When students are finished with the activity, retrieve the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show.

Assessment
Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved by TI-Nspire Navigator. The TI-Nspire Navigator Slide 
Show can be utilized to give students immediate feedback on their assessment.
Summative assessment will consist of questions/problems on the chapter test, inquiry project, 
performance assessment, or an application/elaborate activity.

2-17



 

This page intentionally left blank 

2-18



Kidney Stones, Gravity and the ISS Name

Student Activity  Class 

©2015 Texas Instruments Incorporated 1 education.ti.com

Open the TI-Nspire™ document 
Kidney_Stones_Gravity_and_the_ISS.tns.

NASA’s operating budget has been reduced, and to save money 
NASA has outsourced their Astronaut Health Maintenance (AheM) 
to your company, HumaDyne. NASA requires a health assessment 
report for their astronauts on each body system before they can 
start their next mission.   

Your department in HumaDyne deals exclusively with the excretory 
system; specifically you are to assess each astronaut’s risk of 
developing kidney stones. However, your company is also reducing 
their budget so you only have a conductivity probe. Using this probe, 
you will determine the conductivity of each astronaut’s sample, assess 
their risk from the data, and submit a report from your department.

Move to pages 1.3 – 1.5.

Background Information: Exposure to microgravity, such as on the International Space Station and 
other spacecraft, can cause negative physiological changes in humans both during and after a mission. 
For example, during a flight, the amounts of dissolved calcium, phosphates, and sodium in urine 
increases while the volume of urine itself decreases. These conditions lead to a higher risk of 
developing several kinds of kidney stones. The chemical composition of urine changes after the mission 
as well. These changes also result in a higher risk of developing kidney stones in addition to uric acid. 

Q1. Explain how prolonged exposure to microgravity can impact a person’s health.  

Q2. Which of the following statements is an accurate reason as to why astronauts are at a high risk of 
developing kidney stones? Select all that apply.

a. Astronauts typically have a lower volume of urine than a person on Earth.
b. Lower levels of sodium are found in the astronaut’s urine.
c. Higher levels of calcium are found in the astronaut’s urine.
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Move to pages 1.6 – 1.7.

On page 1.7 you will see a Vernier DataQuest™ page. The page has been set up for you to collect 
data using Events with Entry mode and will average your data over a 10 second period. Make sure 
your conductivity probe is set to the 0-20,000 us/cm setting. Your teacher has already prepared 4 
astronaut samples for you to measure, each labeled 1, 2, 3 and 4. Using Events with Entry mode, 
find the conductivity of each of the astronaut’s urine sample. Record the data in the following chart:

Astronaut 1 Astronaut 2 Astronaut 3 Astronaut 4

Conductivity 
(μs/cm)

Move to pages 1.8 – 2.1. 

We know the conductivity of the astronauts, however we still do not know how much calcium is in 
their urine. We are going to attempt to recreate the calcium mixture and measure the conductivity.  
Your teacher has already created a “stock solution” of pure calcium. 1mL of the stock solution
represents 10mg of calcium. Start off by measuring 100mL of distilled water and place it into a 
clean beaker. Pour 100mL of distilled water into the clean beaker.

Move to page 2.2.

Plug in your conductivity probe, making sure the lever is still set to the 0-20,000 us/cm setting.  
Place your conductivity probe into the distilled water. Your TI-Nspire™ CX handheld should already 
be set up to collect data using Events with Entry, however if it is not change this setting now. Press 
Play to begin data collection.

Measure 1 mL of the stock solution using a pipet or some sort of dropper. Place 1 mL of the yellow 
stock solution into the beaker filled with 100 mL of distilled water. Slowly stir and take a snapshot of the 
data. A box will pop up asking you to enter a value. Type in 10, representing the 10 mg of calcium 
found in the 1 mL of stock solution. Continue adding in 1 mL of stock solution at a time, using events 
with entry. Repeat until you have reached 30 mL or 300 mg of calcium. 

Record your data on the following page.
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mL of 
Calcium 
Standard 

added

Total 
amount of 
calcium 

(mg)

Conductivity 
(μs/cm)

mL of 
Calcium 
Standard 

added

Total 
amount of 
calcium 

(mg)

Conductivity 
(μs/cm)

1 10 16 160

2 20 17 170

3 30 18 180

4 40 19 190

5 50 20 200

6 60 21 210

7 70 22 220

8 80 23 230

9 90 24 240

10 100 25 250

11 110 26 260

12 120 27 270

13 130 28 280

14 140 29 290

15 150 30 300
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Move to page 2.3.

This table indicates the approximant risk of an astronaut 
developing kidney stones based on a 100 mL urine sample. An 
astronaut found to have less than 100 mg of calcium in his/her 
urine is less likely to develop kidney stones. Using this 
information, and the information we know about our astronauts, 
we will be able to determine the diagnosis. Match the 
conductivity of the astronauts to the conductivity on page 2.2 to 
determine the amount of calcium and the risk for each astronaut.  

The table below indicates the risk of kidney problems in correlation to the amount of calcium 
concentration per 100 mL.

Amount of Calcium Risk of Developing Kidney Stones
<100 mg Low

100-250 mg Average 
>250 mg Increased

Use your information from page 2.2 to determine the astronauts calcium concentration based on your 
conductivity measurements.

Astronaut 
Conductivity (μs/cm)
(from top of page 2 of 

student worksheet)

Amount of Calcium (mg)
(Found using data on page 

3, matching calcium to 
conductivity)

Risk

1 

2 

3 

4 
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Move to pages 2.4 -3.5.

Q3a. Astronaut #1 had a ____ risk.

a. Low
b. Average 
c. Increased

Q3b. Astronaut #1 had this many mg of calcium in his/her urine.

Q4a. Astronaut #2 had a ____ risk.

a. Low
b. Average 
c. Increased

Q4b. Astronaut #2 had this many mg of calcium in his/her urine.

Q5a. Astronaut #3 had a ____ risk.

a. Low
b. Average 
c. Increased

Q5b. Astronaut #3 had this many mg of calcium in his/her urine.

Q6a. Astronaut #4 had a ____ risk.

a. Low
b. Average 
c. Increased
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Q6b. Astronaut #4 had this many mg of calcium in his/her urine.

Q7.  What is gravity?

Q8. How do bones and calcium levels change for someone in prolonged microgravity environments?

Q9. How could the effects of microgravity be reduced or countered onboard the ISS?

Q10. If 89% of Earth’s gravity reaches the space station, how is it possible for the ISS to remain in orbit? 
        Draw a diagram to explain your thinking.

Q11. If 89% of Earth’s gravity reaches the ISS, why do the astronauts still experience weightlessness?
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Science Objectives
Students will assess the risk of kidney stone development in 
four astronauts from the ISS through an analysis of their 
urinary calcium concentration.
Students will relate concepts of gravity to the impact it has on 
astronauts onboard the ISS (International Space Station).

Vocabulary
kidney stone weightlessness
gravity microgravity
inertia concentration

About the Lesson
This lesson involves using a conductivity probe and the 
Vernier DataQuest™ app to create a conductivity vs. 
concentration curve to determine the amount of calcium in 
an astronaut’s urine.
As a result, students will:

Use Events with Entry to create a concentration vs. 
conductivity curve.

Diagnose an astronaut’s risk of developing kidney stones 
when exposed to prolonged period of microgravity.

Gain a better understanding of the effect of gravity on both 
the human body and objects in NEO (Near Earth Orbit).

TI-Nspire™ Navigator™ 
Use the TI-Nspire™ Navigator™ System to…

Send and receive TI-Nspire™ documents. 
Get immediate, impactful feedback on the progress of your 
lesson through formative assessment. 
Display student work and data using Class Capture. 

Activity Materials

Compatible TI Technologies : TI-Nspire™ CX Handhelds, 

TI-Nspire™ Apps for iPad®, TI-Nspire™ Software

Tech Tips: 
This activity includes screen 
captures from the TI-Nspire 
CX handheld. It is also 
appropriate for use with the 
TI-Nspire family of products 
including TI-Nspire software 
and TI-Nspire Apps. Slight 
variations to these directions 
may be required if using 
other technologies besides 
the handheld.
Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.
Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

Lesson Files: 
Student Activity

Kideny_Stones_Gravity_and 
_the_ISS_Student.pdf
Kideny_Stones_Gravity_and 
_the_ISS_Student.doc

TI-Nspire document 
Kideny_Stones_Gravity_and 
_the_ISS_Student.tns
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Pre-Lab Set Up

The teacher will create a “stock” 1 molar salt water solution. (Salt water will be used to simulate the 
calcium concentration in the urine- this does NOT have to be disclosed to students).  To do this the 
teacher will pre-make a 1 molar NaCl solution by dissolving 58.44g of NaCl (table salt) with 1000 mL of 
distilled water to simulate the calcium.  Then, place a few drops of yellow food coloring to add to the 
appearance.  This will be known as the teacher’s “stock solution.”  Place this solution to the side, as this 
will be used to create all of the sample astronaut’s urine.

The teacher will pre-make 4 sample astronaut urine samples for each group.  To do this:

1. Start with 100 mL of distilled water in a beaker.
2. Using the below chart, create an astronaut with a low risk, average risk and increased risk. 

To create an astronaut with a low risk, place 0-9 mL of the stock solution into the 100mL 
sample beaker.   

3. Create a total of 4 astronauts, each with a different amount of calcium.  Label the cups so 
the students know which astronaut is which.

4. Crete an answer key, indicating how many drops of the “stock solution” you used to create 
each astronauts urine sample.

mL of 
teacher 
stock

Calcium amounts
Possible formation of kidney 

stones
Please note that 5mL of 
stock solution equals 50mg 
of calcium. You will have to 
multiply the concentration of 
teacher stock solution by 10 
to get the calcium amount.

0-9 <100 mg calcium Low Risk

10-25 100-250 mg calcium Average Risk

25+ 250+ mg of calcium Increased Risk

Each group will need the following materials in addition to the TI-Nspire™ document and student 
worksheet:

4 astronaut urine samples, premade by the teacher and labeled 1-4 
access to 30 mL of the stock solution
a graduated cylinder, beaker and pipet/dropper
100 mL of distilled water
Conductivity probe with EZ Link
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Discussion Points and Possible Answers

Tech Tip: Have the students plug in the conductivity probe when 
they get on page 1.7.  This will cause the handheld to not make a new 
page, and all of the pre-determined settings will remain in place. 

Move to pages 1.4 – 1.5.

After reading the introductory materials on pages 1.1 – 1.3, 
students will answer the following two questions:

Q1.  Explain how prolonged exposure to microgravity can impact 
a person’s health.  

Sample Answer:  As an astronaut remains in space, they 
lose muscle mass and bone density.

Q2. Which of the following statements is an accurate reason as to why astronauts are at a high risk of 
developing kidney stones? Select all that apply. 

a. Astronauts typically have a lower volume of urine than a person on Earth.
b. Lower levels of sodium are found in the astronaut’s urine.
c. Higher levels of calcium are found in the astronaut’s urine.

Answer:  a and c

Move to page 1.7.

Students are to plug in the conductivity probe when they get to this page. Make sure the 
conductivity probe is set to the 0-20,000 us/cm setting, which can be adjusted by manipulating the 
silver lever on the side of the probe. Students should have their page set up to record data using 
events with entry, along with having the handheld defaulted to averaging the data over 10 seconds. 
The x-axis is labeled astro. for astronaut. The students will press the play button to begin data
collection. They will place the conductivity probe into sample 1 and take a snapshot. The handheld 
will then average the data over a 10 second period. Students should then call this sample 1. They 
will repeat the process for all 4 astronauts. Once completed the students will hit the stop button. 
Students will record their data on their student worksheet on the top of page 2.
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TI-Nspire Navigator Opportunity: Class Capture
See Note 1 at the end of this lesson.   

Move to page 2.2.

Students are to follow the same procedure as they did earlier making sure their device is set up on 
the same setting, events with entry is set to go, and the data will be average over 10 seconds.

This time, however, the students will be using 30 mL of the stock solution you provided them, along 
with 100 mL of distilled water in an attempt to recreate the astronaut urine samples.

Students are to place the conductivity probe into the 100 mL of distilled water. Next, they will slowly 
drop in 1 mL of the stock solution using a pipet/dropper. Students will then stir their mixture and 
press the snapshot icon to record their data. It will ask them to enter a value, which the students will 
call 10. 10 represents the 10 mg of calcium located in the 1 mL of teacher stock solution. Students 
will continue using events with entry as they add in 1 mL of the stock solution at a time, until they 
reach 30 mL of stock solution, also known as 300 mg of calcium.

mL of teacher 
stock added 
to 100mL 
distilled water

Total amount 
of calcium 
concentration 
in mg

Expected 
conductivity 
(us/cm)*

mL of teacher 
stock added to 
100mL distilled 
water

Total amount 
of calcium 
concentration 
in mg

Expected 
conductivity 
(us/cm)*

1 10 1200 16 160 19000
2 20 2300 17 170 20000
3 30 3400 18 180 21000
4 40 4500 19 190 22000
5 50 5400 20 200 22500
6 60 6300 21 210 23000
7 70 7500 22 220 24500
8 80 8300 23 230 25000
9 90 9100 24 240 25500
10 100 10900 25 250 26000
11 110 11600 26 260 26400
12 120 12500 27 270 26900
13 130 14500 28 280 27300
14 140 16000 29 290 27900
15 150 17000 30 300 28400
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The expected conductivity is an estimate. These numbers will vary depending on the accuracy of 
the conductivity probe and the accuracy of the teacher stock solution. Even if yours are not exact, 
it will not change the results that your students will get. All of the numbers will be relative!
**The above chart does NOT get disclosed to the students, this is for the teacher’s eyes only!
Students will record their data on the student worksheet, page 3.

Move to page 2.3

The table to the right is visible on page 2.3. Students will use this 
table to determine the level of risk each astronaut has of 
developing kidney stones. For example, if an astronaut is found to 
have 90 mg of calcium in their urine (9 drops of the stock solution), 
we would say they are at a low risk of developing kidney stones.

Remember, this is determined by matching the conductivity of the 
known astronaut samples to the conductivity vs. concentration 
curve created by the students on page 2.2 of the TI-Nspire™ 
document. Using this information, the students will fill the data table 
out on the bottom of page 4 of their student worksheet.

Move to pages 2.4 – 3.5.

Q3a. Astronaut #1 had a ____ risk.

Sample Answer:  Answers will vary based on the teacher created mixture. If the teacher used 
less than 10 drops in the urine sample, it will be a low risk, if the teacher used 11-24 drops of 
stock solution in the astronaut sample it will be an average risk, and lastly if the teacher used 
25-30 mL of stock solution in the astronaut sample it will be an increased risk.

Q3b. Astronaut #1 had this many mg of calcium in his/her urine.

Sample Answer:  Answers will vary based on the stock solution described in question a above.
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Q4a. Astronaut #2 had a ____ risk.

Sample Answer:  Answers will vary based on the teacher created mixture. If the teacher used 
less than 10 drops in the urine sample, it will be a low risk, if the teacher used 11-24 drops of 
stock solution in the astronaut sample it will be an average risk, and lastly if the teacher used 
25-30 mL of stock solution in the astronaut sample it will be an increased risk.

Q4b. Astronaut #2 had this many mg of calcium in his/her urine.

Sample Answer: Answers will vary based on the stock solution described in question a above.

Q5a. Astronaut #3 had a ____ risk.

Sample Answer:  Answers will vary based on the teacher created mixture. If the teacher used 
less than 10 drops in the urine sample, it will be a low risk, if the teacher used 11-24 drops of 
stock solution in the astronaut sample it will be an average risk, and lastly if the teacher used 
25-30 mL of stock solution in the astronaut sample it will be an increased risk.

Q5b. Astronaut #3 had this many mg of calcium in his/her urine.

Sample Answer:  Answers will vary based on the stock solution described in question a above.

Q6a. Astronaut #4 had a ____ risk.

Sample Answer:  Answers will vary based on the teacher created mixture. If the teacher used 
less than 10 drops in the urine sample, it will be a low risk, if the teacher used 11-24 drops of 
stock solution in the astronaut sample it will be an average risk, and lastly if the teacher used 
25-30 mL of stock solution in the astronaut sample it will be an increased risk.

Q6b. Astronaut #4 had this many mg of calcium in his/her urine.

Sample Answer:  Answers will vary based on the stock solution described in question a above.

Q7.  What is gravity?

Sample Answer:  The force of attraction between all masses in the universe.
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Q8. How do bones and calcium levels change for someone in prolonged microgravity environments?

Sample Answer:  Bone plays an important role as a structure that supports the body and 
stores calcium. It retains fracture resistance by remodeling through a balance of bone 
resorption and formation. In a microgravity environment, because of reduced loading stimuli, 
there is increased bone resorption and no change in or possibly decreased bone formation, 
leading to bone mass loss at a rate of about ten times that of osteoporosis. The proximal 
femoral bone loses 1.5 percent of its mass per month, or roughly 10 percent over a six-month 
stay in space, with the recovery after returning to Earth taking at least three or four years. The 
calcium balance (the difference between intake and excretion), which is about zero on Earth, 
decreases to about -250 mg/day during flight, a value that increases the risk of kidney stones. 

* Bone resorption is the process by which osteoclasts break down bone and release the 
minerals, resulting in a transfer of calcium from bone fluid to the blood.

Q9. How could the effects of microgravity be reduced or countered onboard the ISS?

Sample Answer:  Crew members engage in physical exercise for two and a half hours a day, six 
times a week (fifteen hours a week) while in orbit to avoid these issues. Nevertheless, the risks of 
these problems occurring cannot be completely eliminated through physical exercise alone.

Q10. If 89% of Earth’s gravity reaches the space station, how is it possible for the ISS to remain in orbit?  
Draw a diagram to explain your thinking.

Sample Answer:  Earth's gravity pulls objects downward toward the surface. Gravity pulls on 
the space station, too. As a result, it is constantly falling toward Earth's surface. It also is moving 
at a very fast speed - 17,500 miles per hour. It moves at a speed that matches the way Earth's 
surface curves. If a person throws a baseball, gravity will cause it to curve down. It will hit the 
ground fairly quickly. An orbiting spacecraft moves at the right speed so the curve of its fall 
matches the curve of Earth. Because of this, the spacecraft keeps falling toward the ground but 
never hits it. As a result, they fall around the planet. The moon stays in orbit around Earth for this 
same reason. The moon also is falling around Earth.
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Q11. If 89% of Earth’s gravity reaches the ISS, why do the astronauts still experience weightlessness?

Sample Answer:  The answer is because they are in free fall. In a vacuum, gravity causes all 
objects to fall at the same rate. The mass of the object does not matter. If a person drops a 
hammer and a feather, air will make the feather fall more slowly. But if there were no air, they 
would fall at the same acceleration. Some amusement parks have free-fall rides, in which a cabin 
is dropped along a tall tower. If a person let go of an object at the beginning of the fall, the person 
and the object would fall at the same acceleration. Because of that, the object would appear to 
float in front of the person. That is what happens in a spacecraft. The spacecraft, its crew and any 
objects aboard are all falling toward but around Earth. Since they are all falling together, the crew 
and objects appear to float when compared with the spacecraft.

Wrap Up
Review the student responses using the Review Workspace in the TI-Nspire™ CX Navigator™
Teacher Software

Assessment
Options for assessment include grading the embedded questions in the tns file and saving them to 
the portfolio.  Students may also develop a health assessment plan discussing other factors that may 
affect different body systems.  An extension may be discovering what other body systems will be 
affected when there is an issue with your excretory system.

TI-Nspire Navigator
Note 1:  Make sure all of your students are following along and collecting their data properly using 
events with entry.  Having all of your handheld screens displayed on your computer and/or projector 
will allow you to move freely around the room assisting students, while making sure everyone is in the 
right place.
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Activity Overview
In this activity, you will explore the basic features of the Documents Workspace in the TI-Nspire™ 
Navigator™ Teacher Software. You will add pages with Calculator and Graphs applications, and explore
menus and submenus of each application as well as the five tabs within the Documents Toolbox. 

Materials 
 TI-Nspire™ CX or TI-Nspire™ CX CAS Navigator™ Teacher Software (v4.x) if using TI-Nspire™

CX handhelds

 TI-Nspire™ or TI-Nspire™ CAS Navigator Teacher Software (v3.9) if using TI-Nspire™ CX, 
TI-Nspire™ with Touchpad, or  TI-Nspire™ with Clickpad

Step 1:

Open the TI-Nspire™ CX Navigator™ Teacher Software and click on the Documents tab. A new 
document may be opened by going to File and selecting New TI-Nspire™ Document – Handheld Page 
Size or New TI-Nspire™ Document – Computer Page Size.

The Handheld Page Size allows documents to be viewed on all platforms. The content will be 
scaled when viewed on a tablet or larger screen.
In Computer Page Size, content will not be scaled when viewed on smaller platforms and all 
content may not be visible on a handheld device.

Step 2: 

Go to File > New TI-Nspire™ Document – Handheld Page Size. Select 1:Add Calculator. 

Step 3:

The Calculator application allows you to enter and evaluate 
mathematical expressions as well as create functions and 
programs.

In most cases, each application has a unique menu of 
commands and tools. To view the Calculator menu, go to the 
Documents Toolbox and select the Document Tools tab.
Each item in the Calculator menu has a submenu. 

Explore the various menus and submenus by entering and 
evaluating your own expressions.

Note: To access the Calculator menu on the handheld, 
press b. 
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Step 4:

The Utilities tab contains Math Templates, Symbols, 
Catalog, Math Operators, and Libraries panes. Only one pane is 
displayed at a time, and the Math Templates pane is the default 
pane. Explore each of the other panes by clicking them.

To insert a Math Template into the Calculator application, 
double-click it. Explore various Math Templates by evaluating 
your own expressions involving fractions, exponents, square 
roots, logarithms, and absolute value expressions.

Note: When evaluating expressions, the Calculator 
application displays rational expressions by default. 
To display a decimal approximation on a PC, press 
CTRL + Enter. To display a decimal approximation 
on a Mac, press Command + Enter. 

Step 5:

The Insert menu allows you to insert 
problems and pages, along with each of the 
eight applications. A problem can contain 
multiple pages, and variables that are linked 
within a problem are linked across pages. 

Insert a Graphs application by selecting Insert > 
Graphs. 

The Graphs application allows you to graph and 
analyze relations and functions. Explore the 
various menus and submenus available in the 
Graphs application.
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Step 6:

Graph the function f(x) = x by typing x into the 
function entry line and pressing Enter. 

Rotate the line by hovering the cursor over the 
upper-right or lower-left corner of the graph. 
When the rotational cursor, é, appears, rotate 

the line by clicking and dragging it.

Translate the line by hovering the cursor over 
the line near the y-intercept of the graph. When 
the translational cursor, ö, appears, translate 

the line up or down by clicking and dragging it.

Step 7:

Since you have inserted a Calculator application 
and a Graphs application, your TI-Nspire™
document now has two pages. The Page Sorter
view allows you to view thumbnail images of all 
pages in the current TI-Nspire™ document.

Access the Page Sorter by going to the 

Documents Toolbox and clicking the Page 
Sorter tab. Pages can be rearranged by 
grabbing and moving them. Right-clicking allows 
for pages to be cut, copied, and pasted.

Note: To access Page Sorter in the handheld, 
press /£. To right-click in the 
handheld, press /b. 

2-35



Getting Started with the TI-Nspire™ CX Navigator™ Teacher 
Software      
TI PROFESSIONAL DEVELOPMENT

©2015 Texas Instruments Incorporated 4 education.ti.com

Step 8: 

The Vernier DataQuest™ app can be used to 
collect, view, and analyze real-world data. Insert 
a page with the Vernier DataQuest app by 
selecting Insert > Vernier DataQuestTM. 

Though no data will be collected during this 
activity, the data meter will automatically launch 
when a Vernier sensor is connected to the 
computer’s USB port.

Step 9:

The Documents toolbar allows you to create, open, and save a TI-Nspire™ document. 
Commands such as Undo, Redo, Cut, Copy, and Paste are also available. Explore these 
options by hovering the cursor over each icon. Pages, problems, and applications can be 
inserted and variables can be stored. 

Take a Screen Capture of the current page by selecting Take Screen Capture > 
Capture Page. This Screen Capture can be saved as an image.

Page layouts allow multiple applications to appear on one screen. Explore the various 
page layouts that are available by clicking Page Layout. 

The Document Tools contains tools and commands for 
the current application. These are the same menu options as 
those in the Document Tools tab in the Documents Toolbox. 

To change the fill color, line color, or text color, select an object 
and then select a color from the appropriate menu. To receive 
additional information about a given menu, hover the cursor over 
it. Not all color menus are available in all applications.
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Step 10:

The Status Bar allows the user to access Document Properties, Settings, and to adjust the 
zoom of the SideScreen. 

The Zoom to Fit feature automatically scales the document page to fit the available window 
size. Alternately, the zoom can be manually increased or decreased using the Zoom menu. 
The Boldness feature is enabled when using a PublishView™ document. 

Note:   The Zoom to Fit feature is only available in the TI-Nspire™ CX or TI-Nspire™ CX 
CAS Navigator Teacher Software (v4.x)

Step 11: 

View the Document Properties by going to File >
Document Properties. The Document Properties 
also can be viewed by going to the Status Bar and 
double-clicking Page Size: Handheld or Page Size: 
Computer. The page size displayed depends upon 
the type of TI-Nspire document originally opened.

Step 12: 

View the Document Settings by going to File >
Settings > Document Settings. The Document 
Settings also can be viewed by double-clicking 
Settings in the Status Bar.

Note: To move across fields in the Document Settings window, press TAB. To change the 
setting in a given field, press the down arrow, select the desired setting, and press 
TAB to move to the next field. To exit the window, press ENTER.
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Step 13:

Preview the document in Handheld or Computer view by clicking                                    .

Step 14:

To access the TI-SmartView™ emulator for TI-Nspire, 
go to the Documents Toolbox and select the

TI-SmartView tab.

TI-SmartView emulator has three available views: 
Handheld only, Keypad + SideScreen, and Handheld 
+ Side Screen. Explore each of these views.

The keypad has three available views: Normal, High 
Contrast, and Outline. Click the Keypad Options 
menu and explore each keypad and view.

Note:   If using the TI-Nspire™ or TI-Nspire™ CAS Navigator 
Teacher Software (v3.9), there are emulator keypads 
for TI-Nspire™ CX, TI-Nspire™ with Touchpad, and 
TI-Nspire™ with Clickpad. 

Step 15: 

Documents can be transferred between the computer 
and connected handhelds using the Content Explorer 
in the Documents Workspace. Explore the Content 
Explorer by clicking the Content Explorer tab.

To transfer a TI-Nspire™ document from the computer 
to the connected handheld, locate the document in the 
Computer panel. Click, drag, and drop it into the desired 
handheld or folder in the Connected Handhelds panel.

To transfer a TI-Nspire™ document from the connected
handheld to the computer, locate the document in the 
Connected Handhelds panel. Click, drag, and drop it 
into the desired folder in the Computer panel.
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Open the TI-Nspire document Real_Graphs.tns.

In this investigation, we will interpret the rate of change and initial 
value of functions in light of the situation it models and its graph.
We will be exploring the plots of several sets of data that have been
already been collected. We will be looking for data pairs that show a 
linear relationship and that reveal some contextual pattern. That is, 
if the plot of two data sets seems to form a linear pattern, does the 
relationship seem to make sense in the context of the data?

When looking at a plot, determine 1) if the plot represents a function; 2) if the function is linear; and, 3) 
if both of these are true, what is the function that models the pattern? When a linear function is 
obtained of the form y = mx + b, examine the slope and y-intercept both numerically and contextually. 
That is, explore what the values of m and b are and what they mean in the real world.

To truly “know” a situation, explore it graphically (with a graph plot), numerically (with a table of data), 
and analytically (with an equation or function). In addition to these, provide a context for the situation 
and the ability to communicate about all of these items. 

Move to page 1.2.

The following sets of data exist in this Problem.

Set Name Meaning
bounce_height Height of the bouncing ball above the ground.
c_temp Current temperature in degrees Celsius.
Distance Distance from the start.
Dollar Number of dollar Bills.
f_temp Current temperature in degrees Fahrenheit.
Humidity The current Relative Humidity, in percentages.
k_temp Current temperature in Kelvin, a unit of measurement for temperature.
Nickel Number of nickels.
Price The amount charged for an item.
Profit The amount of money made.
Second The number of seconds that have passed.
Step Steps taken in the walk.
Temp The current temperature.
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1. To start looking at the plots of these data sets, select the x-axis and select the Independent variable; 
then select the y-axis, and choose a corresponding Dependent variable to produce a plot. Create a 
plot for one data set pair and answer the following:

a. What was the choice for the Independent variable?

b. What was the choice for the Dependent variable?

c. Is there a pattern? Explain:

2. Look for functions that are linear. Repeat the process in step 1, and document your work. Record 
the following information: x-variable, y-variable, the plot, whether there is a pattern or not, whether it 
is a function or not, and whether the function is linear or not.

3. If a relationship between two sets of data seems to have a pattern, determine a function that best 
models the pattern found. Are the two variables related?

It might be possible to see if the relationship makes sense before the function is named.
Looking at individual data points on the plot might give some insight also. To do this, hover the 
cursor over a point. 

Note: Also look at the full lists of data by using a Calculator Page by pressing h · within the 

page.

4. It is also possible to look at these lists on a Lists & Spreadsheet page. Add a new Lists & 
Spreadsheet page, and move the cursor to the top of the column. Type the name of a data list, OR 
press h to choose the name from a listing of all data lists.

Tech Tip: To add a Calculator page, select at the top of the 

screen. Then select Calculator. On the keyboard, press , select the 
data list you wish to view from the pop-up menu, then press ENTER. To 
add a Lists & Spreadsheet page, select at the top of the screen. Then 
select Lists & Spreadsheet. Press the top of the spreadsheet to bring 
up the keyboard. Then select the top of a column, press . From the 
pop-up menu, select the data list you wish to view. To add or modify data 
in a spreadsheet cell, double-tap the cell.
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As we try to make sense of any relationship we might see, we want to determine which data pairs seem 
to be connected in a cause and effect manner. In other words, is there a relationship between the data 
for price and the data for humidity? How would someone explain that a price of $1,000 somehow 
determines a Relative Humidity of 49%? 

5. Consider this as different plots are analyzed:
a. Initially, choose only pairs to plot that might be related. If something appears to be linear, can 

the pattern be defended?

b. Report the data pairs that appear to produce functions that are linear, and give the functions in 
the y = mx + b form. 

6. Looking at the slope of the functions of note in the previous problem, report the value, units, and 
meaning of these slopes. 

a. Value:

b. Units:

c. Meaning:

7. Repeat the process from the previous question for the y-intercepts. Don’t forget to give the units 
and meaning in the context of the ordered pairs. 

a. Value:

b. Units:

c. Meaning:
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Move to page 2.1.

Here are some more data sets to examine. Again, we are looking at patterns.

Set Name Meaning
Area The surface area of a wire.
Calorie The number of calories in food.
Degree The angle measure in degree units.
Fin The number of 5 dollar bills.
Heat The temperature at some point.
Hour The hour in a day.
Mass The amount of mass in an object.
Month The number of months from January some year.
Quarter The number of quarters you have.
Radian The angle measure in radians.
relative_humid The Relative Humidity in percent.
Sunlight The amount of sunlight landing on a surface.
Temperature The current temperature.

8. Make a plot for one data set pair, and answer the following:

a. Choice for the Independent variable?

b. Choice for the Dependent variable?

c. Pattern? Explain:

9. Look for functions that are linear. Repeat the process in step 8, and document your work. Record 
the following information: x-variable, y-variable, the plot, whether there is a pattern or not, whether it 
is a function or not, and whether the function is linear or not.

10. Report the data pairs that appear to produce functions that are linear, and give the functions in the
y = mx + b form.
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11. Looking at the slope of the functions of note in the previous problem, report the value, units, and 
meaning of these slopes. 

a. Value:

b. Units:

c. Meaning:

12. Repeat the process from the previous question for the y-intercepts. Don’t forget to give the units and 
meaning in the context of the ordered pairs. 

a. Value:

b. Units:

c. Meaning:
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Math Objectives
 Students will explore the plots of various data sets, looking for 

patterns. 
 Students will identify plots that appear to be functions. 
 Students will determine which plots appear to form a linear 

pattern, and then acquire the best function that models the 
pattern, in the form of y = mx + b. 

 Students will analyze the linear function, looking at the slope and 
the y-intercept in the context of the data that was used. They will 
identify the units of these values and their contextual meaning. 

 Students will use functions to model relationships between 
quantities. 

 Students will interpret the rate of change and initial value of a 
linear function in terms of the situation it models and in terms of 
its graph or a table of values (CCSS Mathematical Standard). 

 Students will apply the mathematics they know to solve problems 
arising in everyday life, society, and the workplace (CCSS 
Mathematical Practice).

 
Vocabulary

 function  linear function 
 model  variables 
 y-intercept  independent variable 
 slope  dependent variable 
 table  set 

About the Lesson
 This lesson involves identifying patterns of data from given lists. 
 As a result, students will: 

 Identify patterns that might represent functions, and in 
particular, linear functions. 

 Represent realistic relationships. 
 Identify the best function to fit the data and examine its parts 

in context. 

TI-Nspire™ Navigator™ 
 Transfer a TI-Nspire document. 
 Use Class Capture to examine student work and responses. 
 Use Live Presenter to allow the students to demonstrate their 

technique. 
 Use Quick Poll for Formative Assessment and reporting. 

Activity Materials

 Compatible TI Technologies:  TI-Nspire™ CX Handhelds, 

 TI-Nspire™ App for iPad®,  TI-Nspire™ Software 

 
 
Tech Tips
 This activity includes screen 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

 Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 

 Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

Lesson Files:
Student Activity
 Real_Graphs_Student.pdf
 Real_Graphs_Student.doc

TI-Nspire document 
 Real_Graphs.tns 
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Discussion Points and Possible Answers 
 

 
 

Teacher Tip: Students will need to be familiar with the graphical and 
analytical views of a linear equation. That is, they should recognize a linear 
graph when they see it, and they should be familiar with y = mx +b form. 
Note that in actual collected data, the vertical line test for a function might 
appear to fail. Given that all measured numbers have an uncertainty (see 
sig-figs), an x-value might appear to precipitate two different y-values. 

 
When looking at a plot, determine 1) if the plot represents a function; 2) if the function is linear; and, 3) 
if both of these are true, what is the function that models the pattern? When a linear function is 
obtained of the form y = mx + b, examine the slope and y-intercept both numerically and contextually. 
That is, explore what the values of m and b are and what they mean in the real world. 

To truly “know” a situation, explore it graphically (with a graph plot), numerically (with a table of data), 
and analytically (with an equation or function). In addition to these, provide a context for the situation 
and the ability to communicate about all of these items.  

 
Move to page 1.2. 
 
The following sets of data exist in this Problem. 

 

 

Set Name Meaning
bounce_height Height of the bouncing ball above the ground. 
c_temp Current temperature in degrees Celsius. 
Distance Distance from the start. 
Dollar Number of dollar bills. 
f_temp Current temperature in degrees Fahrenheit. 

Humidity The current Relative Humidity, in percentages. 
k_temp Current temperature in Kelvin, a unit of measurement for temperature. 
Nickel Number of nickels. 
Price The amount charged for an item. 
Profit The amount of money made. 
Second The number of seconds that have passed. 
Step Steps taken in the walk. 
Temp The current temperature. 
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1. To start looking at the plots of these data sets, select the x-axis and select the Independent 

variable; then select the y-axis, and choose a corresponding Dependent variable to produce a plot. 
Create a plot for one data set pair and answer the following: 

a. What was the choice for the Independent variable?
b. What was the choice  for the Dependent variable? 
c. Is there a  pattern? Explain: 

 
Sample Answers: Student answers will vary. 

 
Teacher Tip: Students should explore the plots of various sets using some 
list for the x-axis and a different one for the y-axis. It is not particularly 
important to have any pattern in their choices initially. Once they find a 
pattern, they then should determine if this is just a coincidence, or if this 
pattern actually represents a relationship between the two variables. As 
this lesson progresses, the students should pick the data pairs with some 
thought in mind that they might be related. 
The students will need to introduce new Pages into the document to create 
additional plots as they start the documentation process. They might also 
want to build a table in their documents to record their work.  

2. Look for functions that are linear. Repeat the process in step 1, and document your work. Record 
the following information: x-variable, y-variable, the plot, whether there is a pattern or not, whether it 
is a function or not, and whether the function is linear or not. 

 
Sample Answers: 

 
x-

variable
y-

variable
Plot Pattern Function Linear

price Nickel 

 

Yes Yes Yes 
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price Humidity 

 

Maybe Probably 
not 

No 

 
OR in a spreadsheet: 

 
 

Tech Tip: Variables in Problem 1, in this case Lists, are known only in 

this Problem by the TI-Nspire. When you move to Problem 2, we have 
another set of variables. Tabbing is the quick way to move from x-axis 
selection to y-axis selection and the graph area. Students can also move 
their cursors and select an area to get to these locations. Right-select will 
give more options on the x-axis, the y-axis, and the graph area. Note that 
the Caption option at the top of the page is set to <none>, so what we see 
are points that randomly represent a row of the data lists.  
As they document their work, students will need to avoid using the exact 
list name, since the names are already known to the TI-Nspire as a list 
(variable) rather than simply a name. If they place the name for the list in 
quotes, this is not a problem. Add pages and applications quickly by using 
the keystrokes / I.

TI-Nspire Navigator Opportunity: Class Capture and Live Presenter
See Note 1 at the end of this lesson. 
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3. If a relationship between two sets of data seems to have a 
pattern, determine a function that best models the pattern found. 
Are the two variables related? 
 It might be possible to see if the relationship makes sense 

before the function is named. 
 Looking at individual data points on the plot might give some 

insight also. To do this, hover the cursor over a point. 

Note: Also look at the full lists of data by using a Calculator Page 
by pressing h · within the page. 

 

4. It is also possible to look at these lists on a Lists & Spreadsheet 
page. Add a new Lists & Spreadsheet page, and move the cursor 
to the top of the column. Type the name of a data list, OR press 
h to choose the name from a listing of all data lists. 

 

Tech Tip: To add a Calculator page, select at the top of the 

screen. Then select Calculator. On the keyboard, press  , select the 
data list you wish to view from the pop-up menu, then press ENTER. To 
add a Lists & Spreadsheet page, select at the top of the screen. Then 
select Lists & Spreadsheet. Press the top of the spreadsheet to bring 
up the keyboard. Then select the top of a column, press  . From the 
pop-up menu, select the data list you wish to view. To add or modify data 
in a spreadsheet cell, double-tap the cell. 

 

Tech Tip: If the student only highlights the top “cell” on a column and 
presses h, they will be prompted to choose from a menu. They should 

then select “Select 3:Link To:” and move to the name of their desired list. If 
they press · after selecting 3, the list of variables will appear with the 
selection of the h key. 

TI-Nspire Navigator Opportunity: Class Capture and Live Presenter
See Note 2 at the end of this lesson. 

 

 

2-49



Real Graphs TEACHER NOTES

MATH NSPIRED  

©2014 Texas Instruments Incorporated 6 education.ti.com

As we try to make sense of any relationship we might see, we want to determine which data pairs seem 
to be connected in a cause and effect manner. In other words, is there a relationship between the data 
for price and the data for humidity? How would someone explain that a price of $1,000 somehow 
determines a Relative Humidity of 49%?  

5. Consider this as different plots are analyzed: 
a. Initially, choose only pairs to plot that might be related. If something appears to be linear, can 

the pattern be defended? 
 

Answer: The relationships noted in the table below are all inverses. 
 

b. Report the data pairs that appear to produce functions that are linear, and give the functions in 
the y = mx + b form. 

 
Answer:

 
 Independent (x) Dependent (y) Function/Linear

c_temp k_temp y = x + 273.15 
f_temp c_temp y= 5/9 x – 160/9 
k_temp f_temp y = 9/5 x – 459.67 
nickel dollar y = 0.05 x 

price profit y = -2 x + 5000 
second bounce_height Yes/No 
step distance y = 1.32 x 
temp humidity Y = -1.18 x + 94.8 

 

TI-Nspire Navigator Opportunity: Class Capture, Live Presenter, and Quick Poll
See Note 3 at the end of this lesson. 

 
6. Looking at the slope of the functions of note in the previous problem, report the value, units, and 

meaning of the slopes. 

a. Value: 
b. Units: 
c. Meaning: 

 
Sample Answers:
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(x) (y) Slope Units Meaning

c_temp k_temp 1 K/°C There is one Kelvin degree for each 

degree Celsius. 

f_temp c_temp 5/9 °C/°F There are 5 degrees of Celsius for 

every 9 degrees of Fahrenheit. 

k_temp f_temp 9/5 °F/K There are 9 degrees of Fahrenheit for 

every 5 degrees Kelvin. 

nickel dollar 0.05 dollar/nick

el 

There are 5 dollars for every 100 

nickels; or, since 5/100 reduced to 

1/20, you could say 1 dollar for every 

20 nickels. 

price profit -2 dollar/dolla

r 

There is a 2 dollar loss for every 1 

dollar on the price. 

step distance 1.32 feet/step There are 1.32 feet in 1 step. 

temp humidity -1.18 %/°F There is a drop of 1.18% in the 

Relative Humidity for every 1 degree 

increase in the Fahrenheit 

temperature. 
 

Teacher Tip: You might need to do one or two of the “Meaning” of the 
slope items to help students see what you want reported. Direct the 
students to address only one view of the ordered pairs, avoiding the 
inverses, and focusing on the pairings that make the most sense to them. 
For example, is it (nickel,dollar) or (dollar,nickel). Without more information 
on how the data was collected, we might not be able to identify the 
Independent variable. 

 

TI-Nspire Navigator Opportunity: Class Capture, Live Presenter, Quick Poll
See Note 4 at the end of this lesson. 

 
 
 

7. Repeat the process from the previous question for the y-intercepts. Don’t forget to give the units 
and meaning in the context of the ordered pairs. 

a. Value: 
b. Units: 
c. Meaning: 
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Answer:
 

(x) (y) y-int Units Meaning

c_temp k_temp 273.15 K When the temperature is 0 degrees 

Celsius, it is 273.15 Kelvin. 

f_temp c_temp – 160/9 °C When the temperature is 0 degrees 

Fahrenheit it is -17.8 degrees Celsius. 

k_temp f_temp – 459.67 °F When the temperature is 0 Kelvin, it is  

-459.67 degrees Fahrenheit. 

nickel dollar 0 dollar When you have no nickels, you have 0 

dollars. 

price profit 5000 dollar When you charge 0 for the item, you 

make $5000. 

step distance 0 feet When you take 0 steps, you move 0 

feet. 

temp humidity 94.8 % When the temperature is 0 degrees, 

your RH would be 94.8%. 

 
Teacher Tip: As before, you might need to do one or two of the “Meaning” 
of the y-intercept items to help students see what you want reported. 

TI-Nspire Navigator Opportunity: Class Capture, Live Presenter, Quick Poll
See Note 5 at the end of this lesson. 

Move to page 2.1. 
 
Here are some more data sets to examine. Again, we are looking 
at patterns. 
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Set Name Meaning
Area The surface area of a wire. 
Calorie The number of calories in food. 
Degree The angle measure in degree units. 
Fin The number of 5 dollar bills. 
Heat The temperature at some point. 
Hour The hour in a day. 
Mass The amount of mass in an object. 
Month The number of months from January some year. 

Quarter The number of quarters. 
Radian The angle measure in radians. 
relative_humid The Relative Humidity in percent. 
Sunlight The amount of sunlight landing on a surface. 
Temperature The current temperature. 

 
8. Make a plot for one data set pair, and answer the following: 

a. Choice for the Independent variable?
b. Choice for the Dependent variable? 
c. Pattern? Explain: 

 
Sample Answers: Student answers will vary. 

 

Teacher Tip: The second problem below could be optional. The sets are 
separated from the ones in Problem 1 so as to not overwhelm the student. 
The steps are the same as Problem 1. Use the same Teacher Notes, Tech 
Tips, and Navigator Notes as before. 

9. Look for functions that are linear. Repeat the process in step 8, and document your work. Record 
the following information: x-variable, y-variable, the plot, whether there is a pattern or not, whether it 
is a function or not, and whether the function is linear or not. 

 
Sample Answers: Answers might be similar to what was suggested above in Question #2. 
 

10. Report the data pairs that appear to produce functions that are linear, and give the functions in the 
y = mx + b form. 
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Sample Answers: All of these relationships are inverses. 

Independent (x) Dependent (y) Function/Linear
radian degree y = 57.3 x 
heat area Yes/No 
hour temperature Yes/No 
Hour relative_humid Yes/No 
Mass calorie Yes/No 
month sunlight Yes/No 

quarter fin Y = 0.05 x 
 

 
11. Looking at the slope of the functions of note in the previous problem, report the value, units, and 

meaning of these slopes. 

a. Value: 
b. Units: 
c. Meaning: 

 
Sample Answers:

(x) (y) Slope Units Meaning

radian Degree 57.3 °/radians There are 57.3 degrees in 1 radian. 

quarter Fin 0.05 fin/quarte

r 

There are 5 five-dollar bills in 100 

quarters. 
 

12. Repeat the process from the previous question for the y-intercepts. Don’t forget to give 
the units and meaning in the context of the ordered pairs. 

a. Value: 
b. Units: 
c. Meaning: 

 
Sample Answers:

(x) (y) Slope Units Meaning

radian degree 0 ° If you have 0 radians, you have 0 

degrees. 

quarter fin 0 fin If you have 0 quarters, you have 0 five-

dollar bills. 
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Wrap Up 
Upon completion of the lesson, the teacher should ensure that students are able to understand: 

 Two sets of data don’t necessarily have a relationship. 
 How to create and examine a plot of data. 
 How to recognize a function from a plot of data. 
 How to determine if a plot appears to be linear. 
 How to determine a line of best fit for a linear set of data. 
 How to analyze a linear function and make sense of the slope and y-intercept. 
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TI-Nspire Navigator  
Note 1 
Question 2, Class Capture and Live Presenter 
Take screenshots of the student’s first plots and sort; show what they selected; discuss plots that 
have patterns; identify patterns that appear to be linear; show and discuss plots that appear to be 
non-functions; show linear function patterns, show non-linear function patterns. 
Use Live Presenter to have a student show the class how to set up the plots, add pages, and document 
their work in the Lists & Spreadsheet. 

Note 2 
Question 4, Class Capture and Live Presenter 
Take screenshots of the class as they look at the data and have a student become the Presenter to 
show others how to do this. A screenshot showing all of the points as ordered pairs can be arranged 
with some coordination with the class or using the data-aggregation feature. 

Note 3 
Question 5, Quick Poll, Class Capture, and Live Presenter 
Quick Poll the class and collect justifications of a relationship between some pairs that are 
producing plots that appear to be linear. You could also collect the functions for a given plot using 
this option in Quick Poll. Take screenshots to help student see how others are solving the problem. 
Use the Live Presenter option to have a student show how they got the function. 

Note 4 
Question 6, Class Capture, Live Presenter, and Quick Poll 
Take screenshots to show the class how individuals are answering these questions. Use the Live 
Presenter option to have one student explain how they are documenting their answers. Use Quick 
Poll to get some of the answers, such as the units, or values, or meanings for a given data pair. 

Note 5 
Question 7, Class Capture, Live Presenter, and Quick Poll 
Take screenshots to show the class how individuals are answering these questions. Use the Live 
Presenter option to have one student explain how they are documenting their answers. Use Quick 
Poll to get some of the answers, such as the units, or values, or meanings for a given data pair. 
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